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ModusToolbox™ tools package version 3.2.0

A newer version of this document may be available on the web here.

About this document

Scope and purpose

This document describes the features and known limitations for the ModusToolbox™ software provided as part
of the ModusToolbox™ tools package included with the installer.

ModusToolbox™ software is a set of tools that enable you to integrate our devices into your existing
development methodology. ModusToolbox™ software consists of various libraries and middleware on GitHub,
as well as an IDE and tools package installed on your computer. For more details about what is included with
ModusToolbox™ software, refer to the ModusToolbox™ tools package user guide. See also What's included in
this document.

This ModusToolbox™ tools package is a complete release. It includes the latest features from all previous
releases, including patches. This release does not replace any existing installed releases; it installs alongside
them. If you have more than one release installed, refer to the ModusToolbox™ tools package user guide,
"Product versioning" section.

Reference documents
Refer to the following documents for more information as needed:

e ModusToolbox™ tools package user guide

e ModusToolbox™ tools package installation guide

e Training material on GitHub
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Primary changes

1 Primary changes

The overall tools package version 3.2.0 release includes the following updates and features:

1.1 Setup program and web login

In conjunction with the release of the ModusToolbox™ 3.2 tools package, there is a new, separate
ModusToolbox™ Setup program that will be the primary program used to install ModusToolbox™ tools
packages, separate packs, and various related tools. The Setup program is available for download from the
Infineon ModusToolbox™ website. You can also install the Setup program from the Dashboard included in the
3.2 tools package.

[ Dashboard 3.2 — O X:
File Help

Learn Create

g PN Create a new application for ...
@ \ i Target IDE: | IAR Embedded Workbench v
. L 3 NEW

® vy .
@ @ Launch Project Creator
2 4 1 This option opens the Project Creator. After creating an
ModusToolbox 1 T H application, launch Embedded Workbench, create a project,

New to ModusToolbox™ software? ModusToolbox™ Documentation andlozdihe project contechion S cipcll:
IAR Embedded Workbench for ModusToolbox™ User Guide

Install

ModusToolbox Setup is not installed. Use the following link

to install it:

Video Tutorials Infineon Developer Center

- EEN=I . .

ModusToolbox™ Setup 1.0 — O X
File View Help

gLogin {é}l’references
Base Packages

ModusToolbox™ Tools Package 320

ModusToolbox™ Tools Package 310

Additional Packages

[0 ModusToslbox™ Programming tools 100

ModusToelbox PSoC E84 Early Access Pack 022

ModusToolbox™ Software

FarSE UTIITE T0C WEYTSLTY, UTT TIPSy 7 SUTTWal ELuuTS IMTTTEDTT, Oy 61y ¥ 17 TUUTS] TUEPETNTUENTEs = (e

Discovered available tool 'ModusToelbex™ Programming tools, version 1.0.0.714

Parse Local IDC Registry

Discovered installed tool 'ModusToolbex PSoC E84 Early Access Pack, version 0.2.2.1312
Discovered installed tool ‘ModusTnolhox™ Tnnols Packane 32" version 32014707 b

Mext »

For more information about the Setup program, refer to its user guide.

1.2 Updated versions of Eclipse and related plug-ins

In this tools package release, we have updated the version of Eclipse to v4.28 and updated various associated
plug-ins to address several known issues and improve quality in the IDE. We have also modified items in the
Project menu. For more details, see Design impact.
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1.3 Updated BSP Assistant to recognize early access packs

In previous releases, the BSP Assistant was not recognizing that an early access pack was installed and
therefore you could not create BSPs for the given early access device. In this release, the BSP Assistant has been
updated such that if an enabled early access pack includes a device database (device-db), then the BSP
Assistant will use that device-db and ignore any others.

1.4 No longer force fetch library versions by default

In previous releases, when you ran Library Manager update or "make gelibs", the system would do a force fetch
of every library, even those that were up to date. In this release, we changed the behavior to only force fetch
libraries using the latest tag. For example, the system will fetch mtb-hal-catl if set to "Latest 2.X release", but it
will not fetch core-make if set to "3.3.0 release".

In cases where you have libraries with tags that change what they point to, you can override this setting and
force fetch all libraries by setting this environment variable to "true" or "1". For example:

MTB GETLIBS FORCE UPDATE=true

1.5 Option to specify device support location

The -1, --library CLIoption to specify the device support library has been removed from all configurators
except the Device Configurator and BSP Assistant. Having this option in those other configurators created
possible inconsistencies in the set of libraries were being used in an application. Now, those configurators
automatically find the libraries.

1.6 Changes to device database (device-db) and discovering new devices

In order to improve performance, the device-db has been updated to be a library that is dependent on an
application's peripheral driver library (PDL). This means that when you create a new application, the device-db
will be locked automatically to the latest version with the current set of available devices. If at a later time you
want to update your application to use a newer device that is not included in your current device-db, you'll
need to update the device-db (and possibly the PDL) to a newer version using the Library Manager. See Design
impact for more details.

1.7 Updated process to lock latest library versions

As described in KBA239330, the file (locking_commit.log) that was generated by previous ModusToolbox™
releases to keep track of libraries is ignored by Git during the check-in operation to a remote repository. This
created the problem that any subsequent clones of this application would not include this file, and thus would
not track libraries.

To address this issue, we have updated the mechanism to track libraries using a JSON file named
assetlocks.json. Further, if you open an older application in the ModusToolbox™ 3.2 ecosystem, any existing
locking_commit.log file will be converted to an assetlocks.json file.

Note: Make sure you add this assetlocks.json file to source code control.

1.8 Removed Python from Windows tools package

We no longer provide Python, CySecureTools, and pyocd with the Windows tools package. See Design impact
for more details. CySecureTools is being moved to a new package called the Edge Protect Security Suite. This
also includes moving the Secure-Policy Configurator to the new suite.
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2 What's included

This release includes the following tools and versions:

Tool Name Current Release Previous Release
AIROC™ tools 5.0.1 5.0.0
Bluetooth® Configurator 2.90 2.80
BSP Assistant 1.20 1.10
CAPSENSE™ Configurator & Tuner 6.20 6.10
CyBridge 3.6.0 3.5.0
ChipLoad 1.6.2 1.6.1
cymcuelftool 1.0 (no change) 1.0
Dashboard 3.2.0 3.1.0
DetAndID 5.0.1 5.0.0
Device Configurator 4.20 4.10
Device Firmware Update (DFU) Host Tool 2.20 2.0
Eclipse IDE for ModusToolbox™ 3.2.0 3.1.0
EZ-PD™ Configurator 1.30 1.21
Firmware Loader (fw-loader) 3.6.0 3.5.0
GCC 11.3 (no change) 11.3
GNU make Build System (tools-make) 2.2 2.1
JRE (OpenJDK) 17.0.7 11.0.10
KitProg3 2.50.1 2.50.0
LCS Manager 1.10.0 1.0.0
Library Manager 2.20 2.10
LIN Configurator 1.30 1.21
MbtP 5.0.1 5.0.0
modus-shell 1.5.0 1.4.0 (Windows)
1.3.1.69 (Linux/macOS)

Core build infrastructure: 1.2.0 1.1.0

e mtbgetlibs

e mtbideexport

e mtblaunch

e mtbquery

e mtbsearch
OpenOCD (ModusToolbox™-specific) 5.0.1 5.0.0
Project Creator 2.20 2.10
Proxy Helper 1.50 1.40
Python (for Windows) N/A (removed from tools package) 3.8.10

e cysecuretools e 420
QSPI Configurator 4.20 4.10
Secure Policy Configurator N/A (removed from tools package) 1.40
Segment LCD Configurator 1.60 1.51
Smart I/O Configurator 4.20 4.10
SRecord 1.64 (no change) 1.64
USB Configurator 2.60 2.51
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2.1 Supported tool chains

The GCC Arm Embedded toolchain GCC 11 is installed with the ModusToolbox™ software. This toolchain has no
use restrictions and does not require license activation (it is distributed under the terms of the GNU Public
License).

Although not installed with ModusToolbox™ software, the build system also supports these tool chains for most
applications and devices (see the application README.md file for applicable support):

e Arm compiler v6 or newer (Windows and Linux hosts)
e |IAREmbedded Workbench v9 or newer (Windows only)
2.2 Supported boards

The boards available for use varies with different releases of BSPs and libraries on GitHub. You can see the
current list of BSPs in the Project Creator tool using the default manifest URL:

Kit Name MCU/SOC/SIP Connectivity
AIROC™ Bluetocth® BSPs
v AIROC™ Connectivity BSPs

CYW34390TAEVALTF CYW43907KWEBG <none>
CYWI54907AEVALTF CYW34907KWBG <none>
~ PMG1BSPs
PMG1-CY7110 CYPM1011-24L0x| <nonex
PMGI-CYT111 CYPM1111-40LOXIT <none>
PMG1-C¥7112 CYPM1211-40LOXIT <nonex
PMGT-CY7113 CYPMI1311-48LOXI <none>
~ PSoC™4BSPs
CYBCKIT-041-413K CY8C4146A71-5433 <none>
CYBCKIT-0415-MAX CY3C4149A71-5592 <none>
CYBCKIT-0455 CYBCA348AZI-5485 <none>
CYSCKIT-145-40:¢ CYBCAD45A71-5413 <none>
CY8CKIT-149 CYBCA14TAZI-5475 <none>
PSOCA4-GENERIC CY3C4548A7-5485 <none>
v PSoC™ BBSPs
CYBCEVAL-06252 CV3C624ABZI-52D44 <none>

CYBCEVAL-06252-LAI-4373M2  CVBCH24ABZI-52044 CYW43T3EUBGT
CYBCEVAL-06252-MUR-43439M2 CYBCE24ABZ]-52D44 CYW43435KUBG

CYBCKIT-062-BLE CY8C6347BZI-BLD53 <none>
CYBCKIT-06252-43012 CYBCE24ABZ1-52D44 CYW43012COWKWBG
CYBCKIT-06254 CYBC6244L.Ql-54D92 <none>
CYBCKIT-062-WIFI-BT CYBCE247BZI-D34 CYW4343WKUBG
CYBCKIT-064B052-4343W CYBOG44ABZI-52D44 CYW4343WKUBG
CYBCKIT-0645052-4342W CV50B44ABZI-52D44 CYWA243WKUBG
CYBCPROTO-062-4343W CYBC624ABZ1-52D44 CYW4343WKUBG
CYBCPROTO-06253-4343W CY8C6245L0)-53072 CYW4243WKUBG
CY8CPROTO-063-BLE CYBLE-416043-02 <none>
CYBCPROTO-064B051-BLE CYB06447BZI-BLD53 <none>
CYBCPROTO-064B053 CYBO0B445L0I1-53D42 <none>
CYBCPROTO-06451-5B CYB06447B71-D54 <none>
CYBLE-416045-EVAL CVELE-416045-02 <nenes
CYSBSYSKIT-01 CYBCB24AFNI-52D43 CYWA43012TCOKFFBH
CYSBSYSKIT-DEV-01 CYBCH24AFNI-52D43 CYW42012TCOKFFBH
CYWIP6251-43012EVB-01 CYBCE247FDI-D52 CYW43012TCOEKUBG
CYW3P6251-43438EVE-01 CY2C6247BZI-D34 CYW43438KUBG
PSOCE-GENERIC CYBC6347BZI-BLDS3 <none>
v XMC™ BSPs

KIT_XMC14_BOOT_001 AMC1404- 00640200 <none>
KIT_XMC47_RELAX V1 XMCAT00-F144x2048 <none>
XMC-GEMERIC XMC1404-0064x0200 <nenes

Note: Additional boards will be made available on an ongoing basis.

2.3 Open source

Portions of this software package are licensed under free and/or open source licenses such as the GNU General
Public License. Such free and/or open source software is subject to the applicable license agreement and not
our license agreement covering this software package. The applicable license agreements are available online:

https://www.infineon.com/cms/en/design-support/software/free-and-open-source-software-
foss/modustoolbox-foss-packages,
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3 Design impact

This section includes issues and solutions for changes that may impact various designs.

3.1 Python no longer installed for Windows

For several reasons (such as openssl 1.1.1 end of life and future improvements), we removed Python from the
Windows installer of the ModusToolbox™ 3.2 tools package (and all future releases). Python was never included
with the macOS or Linux tools packages, and those users were required to install it as appropriate for their OS.
The primary impact of the removal of Python from the Windows tools package would be for older applications
being migrated to 3.2 that require Python. For example, when running a "make <IDE>" command on older
applications you may see this error:

Python 3 was not found in the user's PATH and it was not explicitly defined in the

CY PYTHON PATH variable. This target requires a python 3 installation. You can obtain
python 3 from "https://www.python.org" or you may obtain it using the following
alternate methods.

In this case, you can update your version of core-make using the Library Manager or set the CY_PYTHON_PATH
variable as instructed in the error message. to resolve the issue. For details about how and when to install
Python, refer to KBA239118.

3.2 Error using local content storage (LCS) feature

Due to the update to the device database, older versions of LCS data will no longer work. When building the
application, you'll see an error such as: Error loading file. No 'device support library'

information found.

To resolve this, connect to the Internet and update the LCS content. For example, run this command:
$HOME /ModusToolbox/tools 3.2/lcs-manager-cli/lcs-manager-cli --update-existing
After it finishes, you can disconnect from the Internet and either update using Library Manager or "make

getlibs". Then, build the application again and it should succeed.

3.3 Building/programming with Eclipse

We have removed some menu items from the ModusToolbox™ perspective in Eclipse. The native commands
were causing projects in multi-core applications to build several times, resulting in very long build times. When
building and programming in Eclipse, use the commands in the Quick Panel to avoid these issues.

[ Quick Panel (4= Variables € Expressions 9 Breakpoints = 8

Eclipse IDE for
ModusToolbox™

» Start

~

+ Dual-CPU_Empty_PSoC6_App (APP_CYBCKIT-06252-43012)

&, Build Application

@ Clean Application
¥ Launches

& Dual-CPU_Empty PSoCh App Debug MultiCore (KitProg2 MiniProg4)
D Dual-CPU_Empty P
&, Generate Launches for Dual-CPU_Empty PSaC6_App

5 App Program Application (KitProg3_MiniProg4)

* Tools

BSP Assistant 1.20
[ Device Firmware Update Host Tool 2,20
[ Library Manager 2.20
mtb-programmer 5.0 w
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3.4 Older applications in updated Eclipse

We updated base Eclipse rich client platform (RCP) in our Eclipse IDE for ModusToolbox™ to the latest version
(4.28). Base Eclipse RCP contains a new feature that explicitly sets encoding for each new project that it creates
and warns that the project has no encoding set if encoding is not set explicitly.

This fix sets encoding to each newly created and newly imported ModusToolbox™ project. So, for new projects
added to the workspace there will be no warning about the encoding issue, and encoding will be set
automatically based on default workspace encoding. Encoding will be set for projects that have no encoding
set explicitly. Encoding in a project that already has it set explicitly does not change during import.

All our legacy projects that were created prior to Eclipse IDE for for ModusToolbox™ 3.2 have no encoding
explicitly set. So, when you open a workspace with apps that were created and imported with Eclipse IDE for
ModusToolbox™ 3.1 or earlier, you'll see the warning: "Project <project name> has no explicit encoding set".
There are a few ways to resolve with issue:

e Delete the project from the workspace and import it again.

e Select the warning in the Problems tab and press Ctrl+1 (or open the pop-up menu and select the "Quick
Fix" option). In the Quick Fix dialog, select the "Set project encoding to ...." option and click Finish.

e Open the Preferences dialog from Window -> Preferences menu. Select General > Workspace and change
Report missing project encoding as: to "Ignore." This option just ignores the issue and does no change a
project itself.

e Manually create/update project the configuration file <project>/.settings/org.eclipse.core.resources.prefs
setting :
- eclipse.preferences.version=1
- encoding/<project>=UTF-8

By default, all our projects are intended to use UTF-8 encoding. When different encoding is set, say UTF-16,
you will see some Chinese or other symbols when opening the README.md of a project inside the Eclipse
IDE for for ModusToolbox™.

3.5 New CAPSENSE™ middleware version

The CAPSENSE™ middleware has been updated to a newer version. In includes several new featires. Refer to
KBA239563 for more details.

If you try to update and save parameters in the CAPSENSE™ Configurator, you will see a pop-up message as
follows:

L,] CAPSENSE™ Configurator 6.20 X

The configuration contains infos:

! 1. Info: The CAPSENSE™ Configurator requires a newer version of the
CAPSENSE™ Middleware. Update the CAPSENSE™ Middleware in your project to
5.0.
Do you want to save the configuration?

Yes No

Release notes 8 002-22557 Rev. *Z
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If you click Yes and save changes, you must also open the Library Manager and update the middleware to the
newer version:

[l Library Manager 2.20

O pd
Settings  Help
Application Directory: | C:/miw/MSCLP_Self Capacitance_Button_Tunir e
—| [¥] Properties  READMEmd  Description
Name Update Available  Remove Property Value ~
~ BSPs
o Mame capsense
(® APP_CYBCKIT-040T (ACTIVE)
~ MSCLP_Self_Capacitance_Button_Tuning Libraries Version A ‘JDDIE\eau &
[Ccapsence K] X Tyse Tatest 5 X telease
cmsis Latest 4.X release
core-lib Location Latest 3. release
core-make

Latest 2.X release .
mtb-pdi-cat2 Saurce 400 release
recipe-make-cat2 Feference Documet 30 1 release

Ml 300 rlease

2100 release
Add BSP Add Library 200 release
Starting to refresh dependencies for project ‘mtb-example-psocd-msclp-csd-button’,
Refreshed all dependencies for project ‘mitb-example-psocd-msclp-csd-button’,
0 emorls), 3 wamingls) v
Update Close
Release notes 9

002-22557 Rev. *Z
2024-03-26



ModusToolbox™ tools package release notes

infineon

Known issues, limitations, and workarounds

4 Known issues, limitations, and workarounds

This section describes the known issues and limitations of this release, and provides workarounds for them:

4.1 ModusToolbox™ issues from previous releases

This document contains only recent issues pertinent to ModusToolbox™ version 3.x. All issues noted in previous
ModusToolbox™ version 2.x releases have been made available online here: KBA236147.

4.2 Proxy

Problem Workaround

When trying to use any of the ModusToolbox™ tools,
you may see an error message similar to the following
about not able to connect to the Internet:

Unable to open file at [URL]

This can happen if you are behind a firewall and do not have
your proxy settings configured. You must set your
HTTP_PROXY and HTTPS_PROXY environment variables, as
appropriate for your site.

In previous versions of the ModusToolbox™ tools package,
these types of errors only affected the Library Manager and
Project Creator. In version 3.x, these errors apply to all tools.

4.3 Device database error

Problem

Workaround

Various tools report an error with the device-db similar to
this:
fatal:'C:/test/ModusToolbox/packs/ModusToolbo

x-Early-Access-Pack/libs/device-db' does
not appear to be a git repository

Remove the .modustoolbox/global directory from user
home and remove the mtb-shared directory from your
application. Then, retry the failing operation.

fatal: Could not read from remote repository.
4.4 BSP Code generation error
Problem Workaround

When generating code after adding one or more BSPs to a
ModusToolbox™ 3.x application, the system displays error
messages similar to the following:

ERROR:Generating code failed. Code generation
errors:

ERROR:- Errors exist in the project's
configuration:

ERROR:There may be an inconsistency between
the *.modus file and the makefile target
configuration device sets.

ERROR:Current Devices: CY8C624ABZI-S2D44,
Sterling-LWB+/CYW43439KUBG

ERROR:Expected Devices: CY8C624ABZI-S2D44

make: *** [../mtb shared/core-make/release-
v3.2.0/make/core/search.mk:45:
C:/c/Switching Power Modes/build/APP CY8CE
VAL-062S2-LAI-
43439M2 /Debug/cyforcebuild.mk] Error 1

ERROR:"make eclipse" failed

This occurs when you have two or more BSPs with
different MCUs and/or companion devices, and they have
BSP names that begin with the exact same characters,
such as:

e MyBSP (CY8C6247BZI-D54 + LBEE5SKL1DX)

e MyBSP2 (CY8C6347BZI-BLD53 + None)

To resolve this problem, open the Library Manager and
either rename or remove the non-active BSP(s) with the
same beginnings of names.

This issue will be addressed in a future release.
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4.5 LCS Manager CLI

Problem

Workaround

The LCS Manager CLI tool does not use the
ModusToolbox™ proxy settings that other tools use.
Depending on your system environment, the LCS
Manager CLI tool might not be able to access and
download data from external repositories (such as
GitHub).

Ensure that your system can access the desired external
repositories by setting up proxy information before using the
LCS Manager CLI tool. If you need assistance, contact your IT
department.

4.6 Crashes on Mac M1/M2

Problem

Workaround

On Mac computers with ARM cores using Rosetta
(M1/M2 processors), various ModusToolbox™ tools
(library-manager, project-creator, device-
configurator, Eclipse, etc.) consistently crash.

Reboot the computer.

This issue seems to occur for a variety of software, not just
ModusToolbox™ tools. Many users have reported that simply
rebooting the computer resolves the issue.

4.7 HTML on Ubuntu 22.04

Problem

Workaround

On Ubuntu 22.04, sometimes HTML documentation
links do not work anywhere. This issue can occur as
documentation not opening at all or opening in the
wrong program (e.g., Notepad, Office Writer, etc.)

Reset the default browser from the Ubuntu 22 Settings Ul
(Settings > Default Applications > Web). Changing this setting
via the BROWSER environment variable, or the xdg-
settings/xdg-mime commands does not work.

4.8 Eclipse IDE

Problem

Workaround

Launching Project Creator from Eclipse intermittently
generates the following error:

Unable to detect Project Creator startup after 10000
ms.

If this problem continues, try starting Project Creator
stand-alone, then import the project using
ModusToolbox import.

And then Project Creator eventually loads.

Close Project Creator and launch it again. The error should not
be generated again.

In the Eclipse IDE for ModusToolbox™ when setting
TOOLCHAIN=ARM, the call stack does not show while
debugging some multithreaded applications (e.g.,
applications that use FreeRTOS).

Add the CFLAGS+=-fno-omit-frame-pointer compiler
flag to the application. You can do this in the application
Makefile or in Eclipse under Properties > C/C++ Build >
Behavior> Build arguments.

When you upgrade a workspace that was created
using ModusToolbox™3.1 or prior, you'll see a warning
that your projects do not have explicit encoding set.

To fix this, right click on each warning message and select Quick
Fix in the context menu. Select the Set project encoding to
'UTF-8' fix and click Finish.
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Problem

Workaround

When you upgrade a workspace that was created
using ModusToolbox™3.1 or prior, your projects build
using one build job.

1. Select a project/application.

2. Open project's/application's properties selecting Project >
Properties from the main menu.

3. Select C/C++ Build tab in the left pane.

4. Select Behavior tab in the right pane.

5. Add either -9 N, where N is a number of desired parallel build
jobs,or ${cy build jobs} dynamic variable in the Build
Arguments field.

After you rename a project, if you quickly try to
rename it again you may get an error.

Wait until renaming finishes before initiating another renaming.
The project itself is not broken. Only its representation in
Eclipse may break. To fix this, remove the project, import and
rename it again.

When you run Eclipse IDE for ModusToolbox™ from a
terminal window on Ubuntu you get notifications
about SLF4J, GLib and SWT GDBus failures.

Ignore these messages. These are Eclipse issues that do not
impact Eclipse IDE for ModusToolbox™ functionality.

When you left-click on a project that is not currently
selected and then quickly right-click on it and select

the ModusToolbox™ item,the context menu is empty.

Left-click to select the project and wait until the Quick Panel
refreshes before right-clicking it to open the context menu. This
issue will be addressed in a future release.

While debugging, if you try to export memory values
to afile by selecting an item in the Peripherals tab,
the values in the file will be all zeroes.

This is an Eclipse Embedded CDT issue. To get a correct export
file, add the Address of the Peripheral directly to Memory
window, and then use the export feature.

) Console [£] Problems =g Progress [ Memory % & Terminal o8BS %8 =B

Menitors o

Add Memaory Monitor

[ Monitor Memary X

Enter address or expression to monitor:

0340290000} v

On Ubuntu 22.04, when opening documentation from
the Project Explorer (right-click Open with > Web
Browser), the file does not open.

Update the Web Browser settings under Window > Preferences
> General > Web Browser to add your chosen browser or xdg-
open as appropriate:

—_— — F—]
I Preferences g 3
type filter text Web Browser
General Add, remove, or edit installed web browsers Q =A™
Appearance The selected web browser will be used by default when web
Compare/Patch pages are opened, although some applications mayalways 5 = Sz out 52| = o
use the external browser.
EnET = Use internal web browser -
Editors 5
© Use external web browser ~ h1. Empty applic|
o Ealztcn External web browsers: h2. Requirem
Keys
Default system web browser New. h2. supporte
Link Handlers =5 - h2. Supporte
) xdg-open g
Network Connectic i L ho Hardwarg)
Natifg Edit External Web Browser x
Perspe
¢ 3
Quick§ Name: Kkdg-open
Search|
securif Location: Just/bin/xdg-open Browse...
Startuf
UlFrea Parameters: %URL%
Works|
Example: -url %URL%
@ A g
@ aed (Use %URL% to include the URL)
—
1 = -
on In-P|

For certain applications (typically a factor of size),
Eclipse may present a "Discover Compilation
Database Settings" dialog displays, which can block
the Ul for several seconds/minutes. This is seen to
happen often after a build of the project.

Right-click the project and select Properties > C/C++ General >
Preprocessor Include Paths > Providers, and deselect the
Compilation Database Parser check box.

Note that this will cause IntelliSense to be disabled for that
application.
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Problem

Workaround

On Ubuntu 22.04, when running the Eclipse IDE for
ModusToolbox™, the launcher window may be
truncated.

This happens because Eclipse v4.28 has not been
updated to address the problem.

Log out of Ubuntu, and then log in again using the Xorg option.

Ubuntu

= Ubuntuon Xorg

<2 Ubuntu

When renaming a multi-core application in the Eclipse
IDE, the core-processor subprojects become regular
folders instead of project folders.

Right-click on each of the core process folders and select
Import as Project. Each folder will become a project folder with
the appropriate name.

Note: After changing the folders to project folders, they retain
the original application prefix name. You can rename them
individually if you prefer.

Note: The Eclipse IDE may display Indexer errors during the
rename process. These errors usually go away when the rename
process is complete.

After completing a build/clean for a multi-core
application, the Eclipse IDE reports a C/C++ Indexer
error message.

The error message doesn't impact functionality. Try restarting
the Eclipse IDE to clear the message.

When using the Eclipse IDE on macOS, if you delete a
multi-core application with several README.md files
open in the editor/viewer, you may see the following
error message: "Failed to create the part's controls."

None. This error message just means the markdown viewer is
trying to read a file that has been deleted. This message doesn't
impact functionality. Simply close the tab and proceed.

For BTSDK applications, various tools such as BTSpy
and ClientControl are not available from the Eclipse
IDE Quick Panel.

This is due to the restructuring of the ModusToolbox™
version 3.0 build system and flow.

To open various tools, navigate to where they are located in the
workspace and launch them manually. By default, all the tools
are located under the ../mtb_shared directory (relative to the
code example directory). For example, BTSpy is located in the
following path:
../mtb_shared/wiced_btsdk/tools/btsdk-utils
ClientControl is located in the following path:
../mtb_shared/wiced_btsdk/tools/btsdk-host-apps-bt-
ble
Other tools are located in different subdirectories under
mtb_shared.
The BTSDK will be updated in a future release to move these
tools into a pack so that they will be available in the Quick Panel
again.

Exporting and importing a multi-core application with
the Eclipse IDE doesn't work.

1. When Exporting a multi-core application using the Eclipse
IDE, include only the main application folder, and exclude
the core project folders and the mtb_shared folder.

2. If you exported the application as an archive, extract it, and
then run Library Manager or make getlibs.

3. In Eclipse, use the Import Existing Application In-Place
option.

The Eclipse IDE for ModusToolbox™ user guide has been

updated to include multi-core application instructions.
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Problem

Workaround

When importing an application in the Eclipse IDE
using the Import Existing Application In-Place
option, there may be an error: "An internal error
occurred..."

[ Problem Occurred - O X

|@| ‘Creating Projects ... has encountered a problem.

"= Aninternal error occurred during: "Creating Projects ...".

If possible, you should start with the Eclipse IDE to launch
Project Creator and create an application. Using this flow, the
process just works.

In some cases, this error may occur because you're attempting
to manually import an application in the same
workspace/folder that already exists in Eclipse.

To resolve this problem, use Import > General > Existing
Projects into Workspace.

When using the Eclipse IDE, the context menu may
show tools for the previously-selected project rather
than the project that was right-clicked.

Left-click to select the project and wait until the Quick Panel
refreshes before right-clicking it to launch the context menu.
This issue will be addressed in a future release.

If you make changes to the BSP using the BSP
Assistant, such as the connectivity module, and then
launch the Device Configurator from the Eclipse IDE
Quick Panel, the Device Configurator may not
recognize that the changes were made.

To fix this, close the Device Configurator, click Refresh Quick
Panel in the Eclipse IDE, and then launch the Device
Configurator again.

4.9 Visual Studio Code

Problem

Workaround

Various ModusToolbox™ GUI tools (Device
Configurator, Library Manager, etc.) fail to start on
Ubuntu when executed from the Terminal window in
VS Code, with the following error:

Failed to load client buffer integration: "wayland-egl"

Available client buffer integrations: ()

No shell integration named "xdg-shell" found

No shell integration named "xdg-shell-v6" found

No shell integration named "wl-shell" found

No shell integration named "ivi-shell" found

Loading shell integration failed.

Attempted to load the following shells ("xdg-shell",
"xdg-shell-ve", "wl-shell", "ivi-shell")

Solution 1: Open an Ubuntu Terminal, navigate to the
application directory, and use the applicable "make"
command to open the GUI (e.g.,make library-manager).

Solution 2: Log out from the current Ubuntu session, and then
log back in and make sure Ubuntu on Wayland is not selected
on the login screen.

ubuntu®

On newer versions of Ubuntu, the login screen will show
"Ubuntu on Xorg".

4.10

Building/programming/debugging

Problem

Workaround

Existing application opened in ModusToolbox™
version 3.1 or later reports "error: unknown
type name 'uint8_t"" or similar compiler errors.

This error is caused by the update to
GCC11.

Add '#include <stdint.h>' in all affected source files.

This issue only applies to applications migrated to 3.1 or later. It will
not occur for new applications created with 3.1 or later tools.
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Problem

Workaround

When callingmake programwith —j flagon
the command line in multi-core applications,
the programming processes get out of sync.
This results in the gprogram starting before the
build finishes. There is no error message
reported.

This issue does not exist when programming
from Eclipse IDE or VSCode.

Since this issue only exists in a scenario in which the user calls make
programwith -5 flag at the application level in multi-core
applications, the current workaround is to run make build -7
and thenrun make gprogram.

This defect is being addressed in the next release.

In the Eclipse IDE, programming a device is
skipped when the device was previously
programmed.

This is expected behavior and there is no workaround. This was a
change made to the launch configurations in Eclipse to support
multi-core debugging.

If you change the MCU/SOC/SIP for the BSP
using the BSP Assistant, the Register View may
not available while debugging using the
Eclipse IDE or VS Code.

This is because the svd file path is not present in the launch
configurations. To fix this, navigate to the application folder and
run make getlibs. The, run make eclipse or make vscode, as
applicable.

The Attach launch config does not work for the
secure lifecycle of AIROC™ CYW20829 devices.

Do not use the Attach launch config for secure lifecycle.

The CySecuretool does not work with PyOCD as
the debugger on macOS M1 CPUs.

No workaround; we do not plan to support PyOCD.

When exporting ModusToolbox™ applications
created for the TRAVEO™ T2G Body High MC
devices to be used with the pVision and IAR
IDEs, there are some limitations using the J-
Link probe (including ETM traces, program, and
debug via the CM7 core).

Use native Arm and IAR probes to work with TRAVEO™ T2G Body High
MC devices.

There is an issue with reset for TRAVEO™ T2G
Body High MC devices in the SEGGER tool. The
Debug launch config does not work properly for
CM7_0 and CM7_1 cores via the J-Link probe in
Eclipse and VS Code IDEs.

To debug the code, use the Attach launch config.

While using the Eclipse IDE on Windows for
various program/debug operations, there's a
plugin issue that prevents the debug port from
shutting down. This could result in abnormal
power consumption, the watchdog timer being
blocked, or the inability to connect in JTAG
mode after a successful connection in SWD
mode.

Reset the device. For example, on the CY8CKIT-062S2-40312 kit, press
the SW1/XRES button.

4.11

Qt-based GUI configurators and tools

Problem

Workaround

On Windows with multiple monitors, Qt based GUI tools, such as the
Device Configurator and Library Manager, may have pop-up dialogs
and/or menu items appearing on a monitor different from that

where the main window is located.

None. This is a known Qt bug:
https://bugreports.qt.io/browse/QTBUG-97533.
A future release of ModusToolbox™ tools
package will be upgraded with the newer version
of Qt where this bug is fixed.
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Problem

Workaround

On Windows with multiple monitors, Qt based GUI tools, such as the | None. This is a known Qt bug:

Device Configurator and Library Manager, may have pop-up dialogs | https://bugreports.gt.io/browse/QTBUG-62113.
not being automatically resized when moving them between A future release of ModusToolbox™ tools
monitors with different scale settings. For example, monitor #1 with | package will be upgraded with the newer version

scaling of 100% and monitor #2 with scaling of 150%.

of Qt where this bug is fixed.

4.12 Library Manager/make getlibs

Problem Workaround

The Library Manager does not list the retarget- | The retarget-io library is not available currently for this device. The
io library for the CYS8CKIT-040T. retarget-io library depends on mtb-hal-cat2, which is not supported

by the CYS8CKIT-040T.

A .mtb file added as a direct dependency to the | This problem occurs when you add a direct dependency using the
deps directory is overridden and removed 'latest-x.y' tag instead of a specific 'release-x.y.z' tag when the BSP or
during themake getlibs operation. another library requires the same library as an indirect dependency.

To ensure your direct dependency is kept, use the 'release-x.y.z' tag
in your .mtb file.

4.13 BSP Assistant

Problem

Workaround

The bsp-assistant-cli tool crashes when trying to create a
BSP within an existing application.

You can use the Library Manager (GUI or CLI) to create a
BSP based on an existing Kit template, and add it as the
Active BSP for your application. Another option is to use
the BSP Assistant GUI instead of the CLI to create a BSP
directly inside the application. You can also use the bsp-
assistant-cli to create a BSP outside an application, and
then use bsp-assistant-cli to import it into the application.

If you edit an older BSP and change the UDB SDIO port
using the updated BSP Assistant 1.10, you need to
manually edit the config/cyreservedresources.list file. The
older BSP Assistant tool warned of this change. The
updated BSP Assistant tool makes this change for you, but
only for BSPs created with the newer version of the tool.

Not editing the config/cyreservedresources.list file will
lead to indeterminant results.

Manually edit the config/cyreservedresources.list file as
described, or use only the BSP Assistant version 1.0 tool to
make changes to older BSPs.

On Windows, the BSP Assistant does not receive error
messages from any configurator that outputs text (such as
device-configurator-cli). This means that the BSP Assistant
may indicate a failure, but not report any error messages
from that configurator.

As an example, if the device-configurator-cli fails when
changing devices, but no message explains why, go to
c:/Users/<username>/AppData/Local/Temp/device-
configurator-cli and find the most recently-created log file.
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4.14 Device Configurator

Problem

Workaround

In the Device Configurator, the analog routing line to the
SAR is not highlighted when a connection is made in the
editor for XMC7xxx devices.

None. This is a display-only issue. There is nothing wrong
with the data. The issue will be addressed in a future
release.

For ModusToolbox™ 2.x applications using PSoC™ 4
devices, if you open the application using ModusToolbox™
version 3.x, the Device Configurator (version 4.0) may
show various errors with various types of connections,
such as SARADC SOC Input, TCPWM
Start/Stop/Capture/Count/Reload Signal, DMA Channel
Trigger Input or connections between pins over Digital
Input and Digital Output.

Select new signals for the invalid connections to resolve
the issues.

For ModusToolbox™ 2.x applications using PSoC™ 4 or
PSoC™ 6 devices, if you open the application using
ModusToolbox™ version 3.x, the Device Configurator
(version 4.0) may show "Resource overused" errors in
some cases where the pin's Digital Input, Digital Output,
and Analog parameters are set at the same time.

Select new signals for the invalid connections to resolve
theissues.

If you have a project and design.modus file with different
manufacturing part numbers (MPNs), and one of the MPNs
is a module, the Device Configurator displays a message
stating that the MPNs differ.

However, included in that message is a statement that the
MPNs are not supported by the device-db. This statement
is incorrect.

You can safely ignore the incorrect statement in the
message. There is no impact to the application.

If one of the WICED Radio Interface personalities is
instantiated in the Universal Digital Block (UDB), it will not
allow picking connections for the DMA signals.

The WICED Radio Interface personalities should not be
used in practice. Instead, to enable communication with
an external radio device from a PSoC 651 device, the
BSP/Application should use the udb-sdio-whd library and
set the appropriate component for the desired port. See
the README.md file contained in the udb-sdio-whd library
for more details.

Additionally, to reserve the appropriate resources so they
do not get overused by the configurator, the board should
include a cyreservedresources.list file next to the
design.modus file. Refer to one of the existing PSoC 6S1
boards (eg: CYS8CKIT-062-WIFI-BT, CYW9P62S1-43012EVB-
01, CYW9P62S1-43438EVB-01, ...) for what this file should
contain.
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4.15 SegLCD Configurator

Problem

Workaround

The SegLCD Configurator may get out of sync with the
Device Configurator design.modus file, which can result in
changes not being saved.

To ensure proper synchronization for these two
configurators, follow these steps:

1. Before launching the SegLCD Configurator, make
sure to save any changes made in the Device
Configurator.

2. Launch the SegLCD Configurator only from the
Device Configurator or from the Quick Panelin the
Eclipse IDE for ModusToolbox™.

3. After making changes in the SegLCD Configurator,
make sure to save those changes and close the
SeglLCD Configurator.

This issue will be addressed in the next release.

4.16 Bluetooth® Configurator

Problem

Workaround

The Bluetooth® Configurator does not automatically
detect the correct device for the application when creating
a new configuration. This issue is applicable to AIROC™
BTSDK [BTSTACK 1.0] devices; for example, CYW20706.

Manually select the first option "AIROC BTSDK [BTSTACK
1.0] (devices)" in the Bluetooth® Configurator Select
Device dialog.

[ Select Device

- Bluetooth® Configurator 2.90 X

Device:

AIROC BTSDK [BTSTACK 1.0] (CYW20706, CYW20719, CYW20735 CYW20721 CYW20813 CYW20820, CYW20835 CYW43012)
[ AIROC BTSDK [BTSTACK 1.0] (CYW20706, CYW20719, CYW20735, CYW20721, CYW20819, CYW20820, CYW20835, CYW43012)
AIROC BTSTACK with Bluetooth LE only [Updatable Stack] (CYW20829, PSoC 63, PSoC 6 with CYW43ioox Connectivity device)

AIROC BTSDK [BTSTACK 3] (CYW5557x, CYW5551x, CYWS591x, CYW43022)
Not for new design: PSoC Bluetooth LE only Legacy Stack (PSoC 63)

When using the Bluetooth® Configurator with AIROC™
CYW20829 devices, the TX power level (dBm) parameter
under the GAP Settings tab has no effect.

General LE  GATT Settings

GAP Settings  L2CAP Settings

X 9

[Enter filertent,

RPA timeaut (5)

Filter accept list size

Leave the default value (0dBm) in this field when using an
AIROC™ CYW20829 device. This issue will be addressed in a
future release.

4,17 CAPSENSE™ Configurator

Problem

Workaround

When using the CAPSENSE™ Configurator to change
parameters for the PSoC™ 4000T device, the tool will allow
an incorrect value for Reference CDAC boost and cause the
application to not work correctly.

If Reference CDAC mode is set to "Auto" and you set the
Compensation CDAC mode value to "Disable", you
must also set the Reference CDAC boost value to
"Disable". The CAPSENSE™ Configurator will not disable
the parameter for you.
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4.18 CAPSENSE™ Tuner

Problem

Workaround

Switching between Synchronized and Asynchronized mode
in the CAPSENSE™ Tuner may not be executed correctly for
PSoC™ 4000T projects in cases where the device is working
in deep sleep mode for substantial periods of time.

In order for the CAPSENSE™ Tuner to switch between
Synchronized and Asynchronized mode, the device
should be in active mode with working I°C or UART
communication channel.

4.19 Documentation

Problem

Workaround

Various documents included with the release may contain
incomplete information, or may not contain up-to-date
screen captures or information.

New versions of documents, including this release notes
document, may be available online at:

ModusToolbox™ Software website
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*B 2019-09-19 | Updates for version 1.1.

*C 2019-10-18 | Updates for version 2.0.

*D 2019-10-21 | Copyright text for FreeType.

*E 2019-11-04 | Added known issues.

*F 2020-03-26 | Updates for version 2.1.

*G 2020-04-07 | Adding Known Issues for version 2.1; fixed Rev. in footer.

*H 2020-04-21 | Adding known Issue for QSPI Configurator.

*| 2020-05-20 Removed fixed known issue.

*J 2020-06-29 | Added known issues for Programming/Debugging.

*K 2020-09-01 Updates for version 2.2.

*L 2020-09-25 | Added several known issues.

*M 2020-10-19 | Added issue about programming in DeepSleep mode.

*N 2020-12-04 | Added issue about Eclipse IDE and macOS Big Sur.

*0 2020-12-10 | Added issued for no access to GitHub.

*P 2021-03-25 Updates for version 2.3. Updated text for M1 workaround. Added issue about importing into
Eclipse.

*Q 2021-04-22 | Updated text for known issue about build failing in Eclipse for imported projects.

*R 2021-07-07 | Added issue for PSoC™ 4 error message that can be ignored.

*S 2021-09-23 Updates for version 2.4.

*T 2021-10-08 Updated the version of modus-shell for Windows to 1.3.0.
Added build issues for legacy BTSDK projects, as well as XMC™ projects using Linux and IAR.

*U 2022-01-26 | Added issue for font size on Project Creator and Library Manager when using multiple
screens.

*V 2022-09-28 Updates for version 3.0 release.

*W 2023-03-21 | Added issue of program starting before build finishes when working with multi-core projects.

*X 2023-06-02 Updates for version 3.1 release.

*Y 2024-02-27 Updates for version 3.2 release.

*Z 2024-03-26 | Added known issue for CAPSENSE™ Configurator, and updated versions of a couple current
assets.
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values stated herein and/or any information
regarding the application of the product, Infineon
Technologies hereby disclaims any and all
warranties and liabilities of any kind, including
without limitation warranties of non-infringement
of intellectual property rights of any third party.

In addition, any information given in this document
is subject to customer's compliance with its
obligations stated in this document and any
applicable legal requirements, norms and
standards concerning customer's products and any
use of the product of Infineon Technologies in
customer's applications.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer's technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

Warnings

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon Technologies,
Infineon Technologies' products may not be used in
any applications where a failure of the product or any
consequences of the use thereof can reasonably be
expected to result in personal injury.
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